Face & Iris Recognition Research

Prof. Vijayakumar Bhagavatula
kumar@ece.cmu.edu
http://www.ece.cmu.edu/~kumar/
Acknowledgments

- Dr. Marios Savvides
- Dr. Chunyan Xie
- Dr. Jason Thornton
- Dr. Krithika Venkataramani
- Dr. Pablo Hennings
- Naresh Boddeti

- Technology Support Working Group (TSWG)
- CyLab
Outline

- Use of spatial frequency domain for biometric image recognition --- Correlation filters
- Face recognition
  - Face recognition grand challenge (FRGC)
  - Simultaneous Super-Resolution & Recognition ($S^2R^2$)
- Iris recognition
  - Iris challenge evaluation (ICE) 2005
  - Extended depth-of-focus iris recognition
- Summary
Terminology

■ **Verification (1:1 matching)**
  - Am I who I say I am?
  - Example applications: Trusted Traveler Card, ATM access, Grocery store access, Benefits access

■ **Identification (1:N matching)**
  - Does this face match to one of those in a database?
  - Example applications: Watch list, identifying suspects in surveillance video

■ **Recognition** = **Verification + Identification**
Challenge: Pattern Variability

- **Challenge**: To tolerate inter-class pattern variability (sometimes called distortions) while maintaining intra-class discrimination.

- Facial appearance changes due to illumination changes, expressions, pose variations etc.

- Fingerprints affected by rotations, elastic deformations, moisture, etc.

- Iris images affected by eyelid occlusions, eyelashes, off-axis gaze, mis-focus, etc.
Biometric Recognition Approaches

- Statistical pattern recognition (e.g., Minimum error rate methods)
- Nonparametric methods (e.g., Nearest-neighbor methods)
- Discriminant methods (e.g., linear discriminant functions, artificial neural networks, support vector machines, etc.)
- Correlation filters based on 2D Fourier transforms of biometric images
**Correlation Pattern Recognition**

\[ c(\tau_x, \tau_y) = \int \int r(x, y) s(x-\tau_x, y-\tau_y) \, dx \, dy \]

- Determine the cross-correlation between the reference and test images for all possible shifts.
- When the test image is authentic, correlation output exhibits a peaks at that shift.
- If the test image is of an impostor, the correlation output will be low.
- Simple matched filters won’t work well in practice, due to rotations, scale changes and other differences between test and reference images.
- Advanced distortion-tolerant correlation filters developed previously for automatic target recognition (ATR) applications, now being adapted for biometric recognition.

SAIP ATR SDF
Correlation Performance for Extended Operating Conditions
Courtesy: Northrop Grumman

M1A1 in the open
Adjacent trees cause some correlation noise

M1A1 near tree line
Controlled Response to Rotations

\[ c(\theta) = \begin{cases} 
1 & \text{for } |\theta| \leq 45^\circ \\
0 & \text{for } |\theta| > 45^\circ 
\end{cases} \]

Correlation Filters

Test Image → FFT → Correlation Filter → IFFT → Analyze → Decision

Training

Match

No Match

Match quality Quantified by Peak-to-Sidelobe Ratio (PSR)

Peak to Sidelobe Ratio (PSR)

- PSR invariant to constant illumination changes

1. Locate peak
2. Mask a small pixel region
3. Compute the mean and \(\sigma\) in a bigger region centered at the peak

\[
PSR = \frac{\text{Peak} - \text{mean}}{\sigma}
\]

- Match declared when PSR is large, i.e., peak must not only be large, but sidelobes must be small.
CMU PIE Database

CMU PIE Database,
One face under 21 illuminations
65 subjects
Train on 3, 7, 16, -> Test on 10.

Match Quality = 40.95

Ref: Marios Savvides, “Reduced-Complexity Face Recognition using Advanced Correlation Filters and Fourier subspace Methods for Biometric Applications,” Ph.D. Dissertation, CMU, April 2004

Vijayakumar Bhagavatula
Occlusion of Eyes

Using the same filter as before,
Match Quality = 30.60
Un-centered Images

Match Quality = 22.38

PSR = 22.38
Impostor

Using someone else’s filter
PSR = 4.77
Face Recognition Grand Challenge (FRGC)

- To facilitate the advancement of face recognition research, FRGC has been organized by NIST

- 625 Subjects; 50,000 Recordings; 70 Gbytes

FRGC Dataset: Experiment 4

Generic Training Set consisting of 222 people with a total of 12,776 images

Feature extraction

Feature space generation

Reduced Dimensional Feature Space

Reduced Dimensionality Feature Representation of Gallery Set 16,028

Reduced Dimensionality Feature Representation of Probe Set 8,014

Similarity Matching

Gallery Set of 466 people (16,028) images total

Probe Set of 466 people (8,014) images total
FRGC “Gallery” Images

Controlled (Indoor)

16,028 gallery images of 466 people
FRGC “Probe” Images

Uncontrolled (Indoor)
FRGC “Probe” Images

Outdoor illumination images are very challenging due to harsh cast shadows

Uncontrolled (Outdoor)
The verification rate of PCA is about 12% at False Accept Rate 0.1%.

ROC curve from P. Jonathan Phillips et al (CVPR 2005)
Correlation Filters for Face Verification

Only 1 training images
Low performance

Filter Design: OTSDF, CHF, ...

Enrollment

Similarity Score

Verification

256 million correlations
Long time

Vijayakumar Bhagavatula
Class-dependence Feature Analysis (CFA)

- **Motivation**
  - Improve the recognition rate by using the generic training set
  - Reduce the processing time by extracting features using inner products
Class Dependent Feature Analysis (CFA)

Below, we show the building of the correlation filter for class 2
Performance on FRGC Expt. 4

82.4% @ 0.1 % FAR
(Latest Performance)

PCA: Principal Components Analysis
CFA: Class-dependence Feature Analysis
GSLDA: Gram-Schmit Linear Discriminant Analysis
KCFA: Kernel Class-dependence Feature Analysis

Low-Resolution Face Recognition

- In many surveillance scenarios people may be far from the camera and their faces may be small.

- Looking for suspects involves parsing through hundreds of hours of video.

- A terrorist crime was solved in Italy in 2002 by analysis of 52,000 hours of surveillance videos installed in rail stations.

- **Goal**: Match low-resolution probe images to higher resolution training/gallery images.

![Training](image1.png) ![Probe](image2.png)
Super-Resolution with Face Priors
The Image Formation Process

- Inverting the image formation process

\[ y = DHWx + n \]

- Super-resolution algorithms aim to invert this process either directly or indirectly.

See, for example:
Tikhonov Super-Resolution

■ Inverting the image formation process
  By Tikhonov regularization this is

\[ J(x) = \| Bx - \text{Low-res input} \|^2 + \alpha^2 \| Lx \|^2 \]

■ B is the image formation process operator
  - Downsampling using a model of the detector PSF
  - Blurring my modeling the lens PSF

■ L represents assumptions about the smoothness of the solution
Possible Solutions

1. We can apply a super-resolution algorithm and then classify the result.

2. We can downsample the gallery image and match at the resolution of the probe.
Possible Solutions

1. We can apply a super-resolution algorithm and then classify the result.

2. We can downsample the gallery image and match at the resolution of the probe.

3. We propose an alternative approach which jointly uses super-resolution methods and includes face features for recognition ($S^2R^2$).
**S²R² Simultaneous fit**

- Minimize the regularized functional with classification constraints (for a claimed $k$th class):

$$J(x; k) = \|Bx - \text{Known image formation matrix}\|^2 + \alpha^2 \|Lx\|^2 + \beta^2 \|Fx - f^{(k)}\|^2$$

- Regularization parameters are trained to produce distortions that are discriminatory.
**S²R² Classification**

- Compute measures-of-fit norms and form a new feature vector
- In this example:

\[
r_k = \begin{bmatrix}
    \|B\hat{x} - y\| \\
    \|L\hat{x}\| \\
    \|F\hat{x} - f(k)\|
\end{bmatrix}
\]

- Classify with \( r_k \) using conventional classification methods
Using Features at Multiple Resolutions

Since we know the image formation process

\[
\arg\min_x \|B x - y_p\|^2 + \alpha^2 \|L x\|^2 + \beta^2 \|F x - f^{(k)}\|^2 + \gamma^2 \|F_L B x - f^{(k)}_L\|^2
\]

Features defined as

\[
q^{(k)}_{\hat{x}_p} = \begin{bmatrix}
\|B \hat{x}^{(k)}_p - y_p\|^2 \\
\|L \hat{x}^{(k)}_p\|^2 \\
\|F \hat{x}^{(k)}_p - f^{(k)}\|^2 \\
\|F_L B \hat{x}^{(k)}_p - f^{(k)}_L\|^2
\end{bmatrix}
\]

Gallery image from class \(k\)
Numerical Experiments (I)

- **The MultiPIE database**
  - Total of 337 subjects, compared to 68 of PIE
  - Subjects are captured in several recording sessions with different poses, illuminations and expressions, as in PIE

- **Data set for experiments**
  - Using frontal view, neutral expressions, different flash illuminations
  - Sequestered 73 subjects as generic training set
  - Sequestered 40 subjects to learn regularization parameters
  - The rest 224 subjects are used as gallery and probes
  - Gallery images are not under flash illumination
  - There are a total of 2912 probe images.
Sample from Multi-PIE

Original
24x24
12x12
6x6

Gallery
Probe
Numerical Experiments (II)

- **Proposed framework settings**
  - Base super-resolution algorithm using smoothness constraints as first derivatives approximations
  - Base features are 25 Fisherfaces
  - Final classifier is a Fisher discriminant
  - The image formation process is assumed known
  - Training resolution is 24x24 pixels
  - Simultaneous-fit and measures-of-fit features use face-features at training resolution and probe resolution.

![Graph showing identification accuracy vs. number of pixels.](image)
Still-Image Results Using Multi-PIE

- **Magnification factor of 2**

  Baselines:
  - (Bil) Bilinear interpolation and then matching
  - (Bic) Bicubic interpolation and then matching
  - (Tik) Tikhonov super-resolution and then matching
  - (LR) Matching in the low-resolution domain

  (MFS2R2) Proposed algorithm

  Also shown here:
  - (TrR) Matching in the hypothetical case (oracle) of having probes being available at the base training resolution.

- **Magnification factor of 4**
Still-Image Results Using Multi-PIE (II)

- Magnification factor of 2
- $S^2R^2e$ uses face priors and relative residuals as features
Still-Image Results Using Multi-PIE (II)

- Magnification factor of 4
- $S^2R^2$ with face priors and relative residuals as features

![Bar chart showing identification accuracy (%)]
The proposed S²R² gives super-resolution the objective of recognition, rather than just reconstruction.

We can extract new features by finding a template that fits simultaneously into the available models and features.

We have shown that with simple linear discriminants using these features, we can produce better recognition performance than standard approaches.

This formulation can be easily expanded or generalized to use video, multiple cameras, and even other image representations (such as wavelets) and non-linear features.
Iris Biometric

**Pattern source:** muscle ligaments (sphincter, dilator), and connective tissue

Biometric Advantages

- Extremely unique pattern.
-Remains stable over an individual’s lifetime.
Daugman’s Iris Recognition Method

Circular Edge Detector  Gabor Wavelet Analysis  2048 bits iris code

Iris Recognition: Correlation Filters

We use correlation filters for iris recognition. We design a filter for each iris class using a set of training images.

Determining an iris match with a correlation filter

Iris Pattern Deformation

**Video Example**

Landmark points for all images within one class

Clear deformation from:

- Tissue changes AND/OR
- Deviations in iris boundaries.
**Eyelid Occlusion**

**Example:** Eyelid artifacts in segmented pattern.

![Eyelid Occlusion Example](image)

**Example:** match comparison

For significant portion of area, similarity is lost.
Iris Matching Approach

Problem summary
Accurate pattern matching when patterns experience
- relative nonlinear deformations
- partial occlusions
in addition to blurring and observation noise.

Approach

PROBABILISTIC MODEL:
DEFORM & OCCLUSION STATES

GENERATE EVIDENCE → ESTIMATE STATES → MATCH SCORE

PATTERN SAMPLE

PATTERN TEMPLATE

Vijayakumar Bhagavatula
**Hidden Variables: Deformation**

Iris plane partitioned into 2D field:

\[
\text{Deformation described by vector field: } (\Delta x_i, \Delta y_i) \text{ for } (x, y) \in R_i
\]

Hidden Variables: Occlusion

Occlusion described by binary field:

\[ \lambda_i = \begin{cases} 
1 & \text{if } R_i \text{ is occluded} \\
0 & \text{if } R_i \text{ is unoccluded} 
\end{cases} \]

Hidden vars:

\[ H \triangleq \{ \Delta x_1, \Delta y_1, \lambda_1, \Delta x_2, \Delta y_2, \lambda_2, \ldots \Delta x_N, \Delta y_N, \lambda_N \} \]
Iris Matching Process

Template

Similarity evidence \( \{C_i(x, y)\} \)

New pattern

Eyelid evidence
\( \pi_1, \pi_2, \ldots \pi_N \)

Goal: Infer posterior distribution on hidden states: \( P(H|O) \)

Inference technique:
Loopy belief propagation
Define Experiments

Exp 1
Right Eye
1425 Iris Images
124 Individuals

Exp 2
Left Eye
1528 Iris Images
120 Individuals

112 Overlapping Individuals
132 Total Individuals

Source: Jonathon P. Phillips, NIST
ICE Phase I: Performance

Experiment 1 score distribution

Verification Rate at FAR = 0.1%

Experiment 1: 99.63 %  Experiment 2: 99.04 %
Bar Plot Performance Results
Fully Automatic, FAR=0.001

Results from Open Book Challenge Problem
NOT Independent Evaluation

Source: Jonathon P. Phillips, NIST
Iris On the Move (IOM)
Out-of-Focus Iris Images

Focus

+10cm

+5cm

-5cm

-10cm

Vijayakumar Bhagavatula
Pupil Phase Engineering

Wavefront Coded Imaging

Optical System

Processing

Application

Iris recognition processing

Decision

Aspheric optical element.

Digital detector

 Courtesy: CDMOptics

Vijayakumar Bhagavatula
Wavefront Coded Iris Images
Iris Matching Performance: Iris Code

(a) Conventional

(b) Wavefront-Coded

Table: Operational Range Comparison

<table>
<thead>
<tr>
<th>Iriscode</th>
<th>Data Type</th>
<th>Distance (in cm)</th>
<th>Operational Range (in cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conventional</td>
<td></td>
<td>-2.9</td>
<td>2.9</td>
</tr>
<tr>
<td>Wavefront-Coded</td>
<td></td>
<td>-4.8</td>
<td>5.3</td>
</tr>
</tbody>
</table>
Iris Matching Performance: Correlation Filters

(c) Conventional

(d) Wavefront-Coded

Table: Operational Range Comparison (Scenario I)

<table>
<thead>
<tr>
<th>Correlation Filters</th>
<th>Data Type</th>
<th>Distance (in cm)</th>
<th>Operational Range (in cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conventional</td>
<td>-2.7</td>
<td>2.7</td>
</tr>
<tr>
<td></td>
<td>Wavefront-Coded</td>
<td>-6.1</td>
<td>6.5</td>
</tr>
</tbody>
</table>
Summary

- **Correlation filters**
  - Achieve excellent performance in face recognition grand challenge (FRGC)
  - Performed very well in iris challenge evaluation (ICE)
  - Also successful in fingerprint recognition and palmprint recognition

- **Correlation filters provide a single matching engine for a variety of image biometrics — making multi-biometric approaches feasible.**

- **$S^2R^2$ enables the use of low-resolution face recognition**
Our Other Biometrics Research Topics

- Fingerprint recognition
- Palmprint recognition
- Cancelable Biometrics
- Importance of Fourier phase in Biometrics
- Multi-biometrics; Fusion of biometric information
- Pose-tolerant face recognition
- Iris-at-a-distance recognition
- Large population biometric recognition
- Multi-camera face recognition